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NOTICES
Copyright © 2007 SurfControl plc. All rights reserved. 

No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form or by 
any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior permission of 
the copyright owner.

SurfControl is a registered trademark, and SurfControl and the SurfControl logo are trademarks of 
SurfControl plc. All other trademarks are property of their respective owners.

SurfControl Web Filter contains the VeriSign  International Domain Name (IDN) SDK

Copyright  © 2003, VeriSign Inc.

All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted provided that 
the following conditions are met: 

• Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer.

• Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution.                                                      

• Neither the name of the VeriSign Inc. nor the names of its contributors may be used to endorse or 
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND 
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON 
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

This software is licensed under the BSD open source license. For more information visit 
www.opensource.org.

SurfControl Web Filter contains the MD5.H - header file for MD5C.C: Copyright © 1991-2, ROSA Data 
Security, Inc. Created 1991. All rights reserved.
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Finding your way around1
FINDING YOUR WAY AROUND

This guide describes how to configure SurfControl Web Filter for Citrix. Web Filter for Citrix gives you the 
following functionality:

• Secure LDAP communication between Web Filter for Citrix and the domain controller.

• The ability to configure the port between the client and Web Filter for Citrix server.

• Network installation of clients via group policy.

• The ability to make the client invisible to the user.

• Secure communication between the client and the server.

• Increased client deployment security.

For setting up rules that apply to Web Filter for Citrix clients see the Web Filter Administrators Guide. Web 
Filter for Citrix users and hosts can be selected from the Who objects tab.

THE SURFCONTROL CLIENT ADMINISTRATOR
The Client Administrator is where you manage your SurfControl Web Filter for Citrix clients. It contains a 
configurable description of each remote device and it’s settings. Select Client Administrator from the 
Start > Programs > SurfControl Web Filter for Citrix menu to launch the Client Administrator, as shown 
below.

Figure 1-1 The Client Administrator

Once you can see your clients within the Client Administrator you can edit their filter settings. When you 
select an individual client in the top pane of the Administrator, their details will appear in the bottom pane. 
2 Administrator’s Guide SurfControl Web Filter for Citrix v5.5
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Selecting Clients to view and/or configure
To view and configure the filtering of client devices, you need to select the client that you want to configure. 
Select clients individually or in multiples, using the SHIFT or CTRL key. To search for clients which meet 
specific criteria:

• Select Find from the Edit menu.

• Click  Find First  to find one client of a particular type. 

• Click  Find All  to find a group of clients of a particular type.

To change the Client Properties:

1 Select the clients that need changing.

2 Change the properties in the Properties panel and click Commit Changes.

Client Administrator Columns
Every client that appears in the top pane of the Client Administrator, displays the current security settings 
that it has been configured with. Below is a description of the information shown in each column:

• Information column (!) - Signals whether the client has an unacknowledged tamper on it. The column 
shows the medic icon  if the tamper count has increased since the last tamper count was cleared.

• Description - Shows the current description of the client, entered at the time of the client installation. 
This can be edited in the Description text box in the bottom pane of the Client Administrator.

• Offline Action - The current offline action setting in use by the client.

• Unfiltered Ports - The current unfiltered ports setting in use by the client.

• Filter Sensitivity - The current filter sensitivity setting in use by the client.

• Visibility Level - The current visibility level setting in use by the client.

• User Name - Shows the user name that has been applied to, or returned by the client.

• Host Name - Shows the host name that has been applied to, or returned by the client.

• Last Logon Date - The last time the client made an internet request.

• Client Id - The unique identification number of the client. 

• Install Date - The date the client installation took place.

• Platform - The platform installed on the selected client device.

• Tamper Count - Shows the amount of tampers on a particular client device.

Note: If you select multiple clients the only details that will appear in the bottom pane are those 
that are common to each client.
SurfControl Web Filter for Citrix v5.5 Administrator’s Guide 3
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ADMINISTRATOR MENUS
The following menu options are available in the Client Administrator:

FILE 
The File menu enables you to open databases and close the Client Administrator. 

Open 
The Open menu enables you to open a database of Web Filter for Citrix clients to be administered by the 
Client Administrator. Only Web Filter for Citrix compatible databases can be opened in the Administrator.

Exit
Enables you to close the Client Administrator.

EDIT 
The Edit menu enables you search, select and delete clients. 

Find
Find enables you to use a keyword search to locate particular clients. If you have a lot of clients and only 
want to configure those of a certain type, you can use Find to select only those clients that contain the 
criteria that you are looking for. To launch Find, perform the following steps:

1 Choose Find from the Edit menu or click the Find button on the toolbar.

2 The Find dialog box will appear.

3 Enter the text or characters that you want to be included in the search into the Find what text box.

4 Indicate which column you want to search on by selecting or clearing the relevant Search Columns.

5 Click Find First to have the first client that fulfills this criteria highlighted or Find All to have every 
client highlighted.

Find Next 
The Find Next menu item enables you to find the next Web Filter for Citrix client that matches the search 
criteria. 
4 Administrator’s Guide SurfControl Web Filter for Citrix v5.5
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Select All 
Choosing Select All selects all of the clients in the Client Administrator.

Invert Selection
This reverses the selection status of the clients in the Client Administrator. For example, if clients 2, 4 and 
6 are selected and 1, 3 and 5 are not. Selecting Invert Selection will deselect clients 2, 4 and 6 and select 
clients 1, 3 and 5.

Delete Client
Delete Client removes the client from the Client Administrator. If you have not selected Reject new client 
installs in the Server Settings dialog, the client will reappear the next time it communicates with the Web 
Filter for Citrix server.

VIEW
The View menu enables you to specify how you want the Client Administrator to look by adding or hiding 
toolbar buttons and the status bar. You can also use the View menu to change the columns within the 
Administrator: 

Toolbar
Select Toolbar to show the Shortcut buttons or deselect it to hide them.

Status Bar
Select Status Bar to show the status values at the bottom of the Client Administrator or deselect it to hide 
them.

Columns
To sort client data click the Heading at the top of the column. The data will be sorted into alphabetical 
order. Clicking the column again will reverse the order of the sort. This menu contains two sub-menus:

• Reset Positions - If you have moved columns to different places in the table select this to restore all 
columns to their original positions. To move a column to a different position, select the column heading 
then drag and drop it into its new position. You can return it to its original position at any time by 
choosing Columns > Reset Positions.

• Reset Widths - Selecting Reset Widths restores the column widths to their default setting

Refresh 
Selecting Refresh updates the information in the Client Administrator by refreshing the details.

CONFIGURE
The Configure menu enables you to specify global attributes for clients as well as the location and scope 
of your corporate Web Filter installations.
SurfControl Web Filter for Citrix v5.5 Administrator’s Guide 5
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Server Settings 
Server Settings allows you to specify the global default user name and host name, the maximum amount 
of concurrent client sessions after a period of offline activity and whether the Web Filter for Citrix server is 
accepting new clients.

New Client Defaults 
Certain default settings are used when a client is connected to the Web Filter for Citrix server. You can 
change these default values by setting up the New Client Defaults. Any clients that are installed after this 
point will contain these settings. To change default settings for new clients:

1 On the Configure menu, select New Client Defaults.

The New Client Defaults dialog box is displayed:

2 In the New Client Defaults dialog box, enter the following information:

• Offline Action - Set how the client will behave if the Web Filter for Citrix server becomes 
unavailable. See Client Details section on page 10 for more details. The default is Allow All.

• Unfiltered Ports - Set how the client should behave towards ports that are not included for 
filtering. See Dealing with unfiltered ports on page 11. The default is Allow All.

• Filter Sensitivity - Set how much filtering is carried out. See Setting filter sensitivity on page 12 
for more details. The default is Medium.

• Visibility Level - Set how much of Web Filter for Citrix the user sees. See Visibility Level on 
page 12 for further details. The default is Medium.

• Preferred Host Name - Set the name for the device that is being filtered. See Host Name on 
page 13 for more details. The default is client specified.

• Preferred User Name - Set the name for the user of the device that is being filtered. See User 
Name on page 13 for more details. The default is client specified.

3 Click OK.

Client Upgrade Details
Client Upgrade Details specify whether there is an upgrade available for Web Filter for Citrix clients. See 
Chapter 3 of the Starter Guide for more details.
6 Administrator’s Guide SurfControl Web Filter for Citrix v5.5
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Adding Corporate Web Filters 
Not applicable for Web Filter for Citrix.

TOOLS
The Tools menu enables you to set passwords and override them in the event of problems.

Password Bypass Generator
To uninstall a client you need to supply the password that you entered during the client installation. If you 
forget this password you will have to use the Password Bypass Generator to override the original 
password and uninstall the client without it. To generate a new password:

1 Click the Password Bypass button in the Uninstall Password dialog on the client. You will see a 
Password Bypass dialog box which carries a code in the Challenge Code text box. 

2 In the Client Administrator click the Tools menu and select Password Bypass Generator.
3 Copy the Challenge Code from the client into the Challenge Code text box as shown below.

4 Click Generate. A code will appear in the Response Code text box.

5 Go back to the client and copy this Response Code from the server into the Response Code text box 
of the Client Password Bypass dialog.

6 Click OK to proceed with uninstalling the client.
SurfControl Web Filter for Citrix v5.5 Administrator’s Guide 7
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Set Server Pass-phrase
During the installation of the Web Filter for Citrix client on to a user’s device, it registers with the Web Filter 
for Citrix server and it’s details are written to the Web Filter for Citrix database. During this registration 
process the server passes a pass-phrase to the client. The following illustrates how this pass-phrase can 
be used:

PROBLEM

• The Web Filter for Citrix database has been deleted/corrupted and cannot be restored. The server 
administrator creates a new database.

• The client attempts to log onto the server to ask for a categorization. The logon fails because the new 
database contains no details of this client (the client did not register with THIS database during 
installation).

• The client attempts to re-register. Re-registration requires that the client’s details already exist in the 
database. As this is not the case, the client is not allowed to log on to the Web Filter for Citrix server.

SOLUTION

The Set Server Pass-phrase deals with a situation like this in the following way:

• After the administrator has created the new Web Filter for Citrix database, he assigns the same pass-
phrase to this database as the one used for the old database that no longer exists (using the Set 
Server Pass-phrase dialog).

• The client tries to log on to the server for a categorization which fails (because there are no client 
details in the database). The client obtained the pass-phrase during the client upgrade process. It now 
passes this pass-phrase to the server. 

• The server checks that the password matches the one assigned to the new database (which it does 
because the administrator has assigned the old pass-phrase to the new database), then writes the 
client’s details to the new database. It then allows the client to log on.

Setting a new Pass-phrase
If you have created a new database using the Database Creation Tool, the new database will not have a 
pass-phrase assigned to it. To set a new Pass-phrase:

1 On opening the Client Administrator, a message is displayed stating that a Server Pass-phrase has not 
been set. Click OK.

2 In the dialog that follows, enter a pass-phrase for the new database. The Enter existing pass-phrase 
is grayed out because a pass-phrase has not yet been assigned to this new database.

Note: Once you have configured the server to use a new database, you MUST restart IIS. This 
is to ensure that the scnmISAPIExt.dll picks up the new settings.
8 Administrator’s Guide SurfControl Web Filter for Citrix v5.5
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3 Enter a new pass-phrase and confirm it: The new password must be between 8 and 16 characters 
long.

4 Click OK. The next time the client requests a URL category from the server it will be forced to re-logon. 
The pass-phrase will then be passed to it.

Changing a Pass-phrase
If you need to change your pass-phrase you can use the Set Server Pass-phrase utility. Perform the 
following steps to change the pass-phrase:

1 Select Set Server Pass-phrase from the Tools menu.

2 Enter the old password into the Enter existing pass-phrase text box.

3 Enter the new pass-phrase and confirm it. The new password must be between 8 and 16 characters 
long.

4 Click OK. The next time the client requests a URL category from the server it will be forced to re-logon. 
The new pass-phrase will then be passed to it.

HELP
The Help menu contains the About sub-menu which launches the About box. This contains information 
such as the version number of the Web Filter for Citrix installation, the name of the category database and 
how many days are left on your subscription.
SurfControl Web Filter for Citrix v5.5 Administrator’s Guide 9
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CLIENT DETAILS SECTION
The lower pane of the Client Administrator displays configuration information for whichever client is 
selected in the main pane.

CLIENT DESCRIPTION
This reflects the description added during the client’s installation. You can edit the initial description in the 
Description field in the bottom pane. Details relating to the client are shown in the table below. These are 
specified by the client and cannot be edited in the Web Filter Client Administrator.

Table 1-1  Client Details
Field Description

Client ID Unique ID that helps locate a specific client installation. This ID is also visible in the client. 
See Client properties on page 16 for more details.

Platform Type The client operating system. It is useful when locating and/or grouping installations.

Client Type Identifies the Processor, Operating System Description and Language variant of a Web 
Filter for Citrix client.

Client Version Identifies the version number of the Web Filter for Citrix client.

Install Date Date on which the Web Filter for Citrix client software was installed on the selected device.

Last Logon Date Date the client last made an Internet request that was logged by the Web Filter for Citrix 
Administrator.

Tamper Count Should the client detect an unauthorized change to any of the offline log files or the 
gateway URL in the registry, it will notify the server that a tamper has occurred. Once the 
server has been notified that the client has been tampered with, it will increase the tamper 
count for that client.

Password Password that was supplied during the client’s installation process and is required if you 
uninstall the client.
10 Administrator’s Guide SurfControl Web Filter for Citrix v5.5
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OFFLINE ACTION
There may be times when the Web Filter for Citrix server is not available to the client, perhaps because of 
connection difficulties or maintenance. When this happens, the client will try to contact the server on a 
regular basis (every five minutes), until it can re-connect to the server. If the server is busy this can take 
between ten to sixty minutes. While the server is unavailable, the client will be unable to send Web 
requests to the server for categorization, and so must deal with these requests itself. The client can be set 
to perform one of the following: Allow All or Block All. To configure offline action settings:

1 Select the client(s) that you want to set the offline action for.

2 Click the arrow on the Offline Action list to expand it, as shown below:

3 Choose the type of Offline Action that you require, from the list:

• Allow All - All Web requests on the client are allowed whilst the Web Filter for Citrix Server is 
offline.

• Block All - All Web requests are blocked on the client whilst the Web Filter for Citrix Server is 
offline.

4 Click Commit Changes to add the new Offline Action setting to the client in the Web Filter for Citrix 
Client Administrator.

DEALING WITH UNFILTERED PORTS
Filtering of ports depends on what rules you have created and what ports are available to be monitored. 
There are three ways in which these unknown ports can be dealt with: Allow All, Block All and Filter. To set 
the sensitivity for unfiltered ports:

1 Select the client(s) that you want to set the unfiltered ports behavior for.

2 Click the arrow on the Unfiltered ports list to expand it:

3 Choose the type of action that you require for unfiltered ports, from the list.
SurfControl Web Filter for Citrix v5.5 Administrator’s Guide 11
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• Allow All - Allow access to all unfiltered ports without contacting the Web Filter for Citrix server to 
see if there is a rule set up for the port (this is the default).

• Block All - Block access to any unfiltered ports without contacting the Web Filter for Citrix server 
to see if there is a rule set up for the port.

• Filter - Contact the Web Filter for Citrix Server to see if any rules are set to apply to all ports. 

4 Click Commit Changes to save the new Unfiltered Ports setting. 

SETTING FILTER SENSITIVITY
Filter sensitivity enables you to set how much filtering is carried out by Web Filter for Citrix clients. 
Reducing the level of filtering can speed up performance on slow connections, but of course at the same 
time less traffic is filtered. Priority can be assigned on four levels High, Medium, Low and Automatic. To 
configure Filter Sensitivity:

1 Select the client(s) that you want to set the filtering sensitivity for.

2 Click the arrow on the Filter Sensitivity list to expand it:

3 Choose the level of filtering from the list:

• High - All non-HTTP ports and all HTTP requests are categorized. There may be a performance 
impact if the client is making a lot of requests on a slow internet connection.

• Medium - All non-HTTP ports are categorized but only HTTP page requests are categorized while 
Images, sounds, style sheets, and XML requests are not categorized.

• Low - All non-HTTP ports are categorized. For HTTP requests, the URL will be categorized and, if 
allowed the domain level part of the URL is cached for 3 minutes.

• Automatic - The client chooses High, Medium or Low based on the average Web Filter for Citrix 
server response times and pre-configured thresholds.

4 Click Commit Changes to save the new Filter Sensitivity setting.

VISIBILITY LEVEL
You can set Web Filter for Citrix to hide some or all of its features from the user. There are three levels of 
visibility: Full, Medium and Stealth. If the client tries to access a port that is blocked, the user will see a 
warning pop-up, regardless of the visibility setting.

1 Select the client(s) that you want to set the visibility level for.
12 Administrator’s Guide SurfControl Web Filter for Citrix v5.5
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2 Click the arrow on the Visibility Level list to expand it:

3 Choose the level of visibility from the list:

• Full - Full visibility. All features and pop-ups will be visible to the user.

• Medium - The user interface and critical messages will be visible to the user but pop-ups will be 
disabled. This is the default setting for a new client.

• Stealth - Features will not be visible to the user. Only pop-ups containing critical messages will be 
shown.

4 Click Commit Changes to save the new Visibility setting.

User Name
The User Name is the name that the Web Filter for Citrix server uses when checking Internet requests 
against the rule set. It must be set to Client specified, otherwise the Web Filter for Citrix server will not be 
able to check the user name against rules.

Host Name
The Host Name specifies which Citrix server is handling an Internet request, so you can create rules to 
control what requests a specific Citrix server is allowed to make. It must be set to Client Specified 
otherwise the Web Filter for Citrix server will not be able to check the host name against enabled rules.

PASSWORD
This is the password that is needed to uninstall the Web Filter for Citrix Client.

Note: The client interface will be displayed when an upgrade is available, even if the client is 
set to Stealth mode
SurfControl Web Filter for Citrix v5.5 Administrator’s Guide 13
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OTHER CONFIGURATION
Once you can see your clients within the SurfControl Client Administrator you can select and edit any of 
them. These clients can then be added to SurfControl Web Filter for Citrix rules so that you can apply your 
company filtering policy to them.

PORTS THAT CAN BE FILTERED
To reduce the amount of communication between Web Filter for Citrix clients and servers, the clients only 
communicate activity on those TCP ports of interest. To perform filtering on a specific port, an appropriate 
protocol/port ‘Where’ object must be applied to rules. Those rules that do not contain a protocol/port 
‘Where’ object are assumed to apply to HTTP ports only. The SurfControl Web Filter for Citrix client only 
filters ports that appear in active rules.

PORTS THAT CAN BE MONITORED
You can set the protocols to be monitored or unmonitored. The SurfControl Web Filter for Citrix client both 
filters and intercepts activity on those ports chosen to be monitored within the SurfControl Web Filter 
Manager, and informs the Web Filter for Citrix server.

Monitoring issues with Web Filter for Citrix
In the Site Details and User Details panes, the ‘Bytes Sent’, ‘Bytes Received’ and ‘Duration’ fields will not 
display data because of the way in which the Web Filter for Citrix client and server communicate.

SECURITY AND WEB FILTER FOR CITRIX
SurfControl Web Filter for Citrix now offers support for secure connection:

• Between the Web Filter for Citrix server and your LDAP server

• Between the Web Filter for Citrix server and client.

Web Filter for Citrix server and LDAP server
A secure connection can now be made between the Web Filter for Citrix server and your LDAP server. You 
can change the security setting specified during installation, by editing the SecureConnection registry 
setting. 

1 Open the registry using regedit and navigate to:

HKEY_LOCAL_MACHINE\SOFTWARE\JSB\SurfControl Scout

2 Set the SecureConnection DWORD value:

• 1 - gives a secure connection though there will be an impact on connection speed.

• 0 - connection is faster but unsecure.
14 Administrator’s Guide SurfControl Web Filter for Citrix v5.5
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THE WEB FILTER FOR CITRIX CLIENT
If a client is not set to Stealth, it will inform any user of any change in the way it is filtering. If a request is 
denied the user will see an appropriate Deny page corresponding to the rule that has been triggered. Non-
HTTP requests (including HTTPS) will show a pop-up window containing a message if the visibility level on 
the client is set to 'Full'. These will also be recorded in a Message history window with the most recent 
messages at the top. These messages are not permanently stored.

CLIENT STATUS ICONS
Once the Web Filter for Citrix client is installed on the Citrix server, your users will see an icon in the status 
area (as long as the client visibility is not set to Stealth). The available icons are described in the table 
below:

Table 1-2  Client Icons

Note: Client properties cannot be seen if the client visibility is set to Stealth.

Icon Description

The Web Filter for Citrix Server is offline, and offline action is set to Allow All.

Server is offline, and offline action is set to Block All.

The product Icon. This is used while the client is using the Web Filter for Citrix Server for filtering.

The client is waiting for the user to access the Internet before trying to log on to the Web Filter for Citrix 
server.
SurfControl Web Filter for Citrix v5.5 Administrator’s Guide 15
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CLIENT PROPERTIES
Web Filter for Citrix client properties can be seen by double-clicking the Web Filter for Citrix icon in the 
Notification Area (see Figure 1-2). You can also right-click the icon and select Open from the pop-up 
menu. This will launch the Web Filter for Citrix dialog box which contains the following tabs:

• General

• Messages

• About

General
The General tab contains three sections:

Figure 1-2 Web Filter for Citrix General tab

• Details - This shows a summary of the Web Filter for Citrix client settings, showing how filtering is set 
up, the client ID (this can be given by the user to an administrator or Technical Support so that they can 
identify the device within the Web Filter for Citrix Administrator) and the level of filtering sensitivity. See 
Setting filter sensitivity on page 12 for more information on this setting.

• Categorization Statistics - Every time an Internet request is made, the Web Filter for Citrix client 
contacts the Web Filter for Citrix server to have the request categorized and have any appropriate 
rules applied. Server Response (Last) shows how quickly the server responded to the client’s last 
request while Server Response (Average) gives an average of the speed of communication based on 
the response times it has collected. If the last categorization failed the last response time will be 
preceded by the word Failed. 

For example; 

– If the last categorization took 10 ms: Server Response (Last) 10ms.

– If the last categorization failed: Server Response (Last) Failed 65000ms.
16 Administrator’s Guide SurfControl Web Filter for Citrix v5.5
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• Actions - Clicking Synchronize with Server immediately updates the client with any client side 
changes made on the Web Filter for Citrix server.

Messages
Every time there is a change in the way the Web Filter for Citrix client is filtering, it will display a message 
relating to what has occurred, as shown in the figure below. These messages are stored in the Messages 
pane with the most recent at the top:

Figure 1-3 Web Filter for Citrix Messages tab

About
The About tab displays the version number of the product and can be useful as a reference for upgrading.

CLIENT SECURITY
During installation, the Web Filter for Citrix server’s contact information is stored in the registry of the client 
machine as the Gateway URL. Some users may try to change this URL to avoid being filtered. The client 
can detect unauthorized changes and automatically repair invalid entries. It does this in the following way:

• If the gateway URL in the registry is not formed correctly, it will instantly be replaced with the last 
gateway URL that was used  by the client to successfully contact the server. A tamper will be logged.

• If the gateway URL contained in the registry is valid but cannot be contacted, the client will enter it's 
default offline action state. It will then check the gateway URL periodically for a specified period of time 
(24hrs by default). 

Note: Clicking Synchronize with Server will not update the last response time.

Note: If the client visibility is set to Medium, only messages concerned with blocked ports, 
tampers and upgrades will be displayed.
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• If the server cannot be contacted after the specified time period, the gateway URL in the registry, and 
the last successfully connected gateway URL will be compared. 

– If the two are different, the gateway URL in the registry will be changed to match the last 
successful gateway URL. A tamper will be raised and the client will attempt to connect to the 
server using the updated gateway URL in the registry.  

– If the two gateway URL's are the same, the client remains in it's offline state and will periodically 
poll the server.

GROUP POLICY AND CLIENT CONFIGURATION
It is now possible to use Group Policy to configure the Web Filter for Citrix server (and port) to be used by 
clients. The instructions below outline the steps that must be followed in order to add the new SurfControl 
template to the Administrative Templates within a Group Policy Object, as well as how to configure the new 
server information.

The following instructions assume that you are familiar with Active Directory and using the Microsoft Group 
Policy Manager to apply policies to machines or groups of machines. 

1 Open Group Policy Manager on the Web Filter for Citrix server.

2 Right-click the Default Domain Policy object and select Edit.

3 In the Group Policy Object Editor select Computer Configuration > Administrative Templates.

4 Right-click and select Add/Remove Templates.

5 In the Add/Remove Template dialog that displays click Add.

6 Navigate to the Scmfcli.adm file. By default this will be stored in:

C:\Program Files\SurfControl\Web Filter\Tools

7 Select the file Scmfcli.adm and click Open.

8 Click Close in the Add/Remove Templates dialog.

9 Expand the Administrative Templates folder in the Group Policy Manager and you will now see a list of 
directories beneath it.

10 Select SurfControl Web Filter for Citrix Client then select Server URL in the right-hand pane.

11 Right click the Server URL and select Properties.

12 Select the Enabled option. This will enable the URL text box underneath. Enter the following URL:
<protocol>://<server.domain:port>/scnmgw/scnmisapiext.dll

where <protocol> is either http or https and <server.domain:port> is the name of your server and 
domain. The optional port specification, :port, enables you to use a different port to the defaults of 80 
for http and 443 for https.

The following options are available to select:

Caution: Do not alter the name, or the path to the dll.
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• Not Configured - A Group Policy URL has not been added.

• Enabled - The Group Policy URL will override the default Gateway URL setting in the registry.

• Disabled - The Group Policy URL has been added  but it has been disabled.  The default Gateway 
URL will be used.

13 Click OK.

CONNECTIONS BETWEEN CLIENT AND SERVER USING SP2
If you are using IIS v5.0, once a connection to an ISP is established it is maintained and remains open 
indefinitely until the client logs off. This may be a problem if you have to pay for your network use on a ‘pay 
for time used’ basis. This is not an issue with IIS v6.0 so upgrading to this IIS version should fix the 
problem.
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TROUBLESHOOTING
If you are encountering difficulties with a client, we recommend that you perform the following procedures 
in the order listed. It is advisable to retest the client between each step:

• Try closing and restarting the problematic application.

• Open the Web Filter for Citrix client UI, and click Synchronize with Server.

• Restart the computer.

• Check the Web Filter for Citrix Web site for an up to date list of known problems.

• Re-run the Web Filter for Citrix client setup and try the repair option.

• Uninstall the Web Filter for Citrix client software, restart the computer and then reinstall the software.

CLIENT NOT FILTERING
Web Filter for Citrix has the intelligence to know when it is in the company environment so that it will switch 
off and leave the filtering to the company web filter. It does this by recognizing the range of IP addresses 
that it is exposed to and recognizing that it is within it’s own network. However, companies can use ranges 
of IP addresses which can be duplicated across different companies. If the Web Filter for Citrix client 
should go into an environment that consists of IP addresses within the same range of those of the 
company from which it originates then it will think that it is now within its own company and will switch off.

CLIENT NOT PICKING UP CHANGE TO OFFLINE ACTION
When a Web Filter for Citrix client cannot communicate with the Web Filter for Citrix Server, perhaps 
because the server is offline, the Web Filter for Citrix client applies filtering to the device depending on the 
Offline Action that was present within the Client Administrator at the last successful connection to the Web 
Filter for Citrix Server. This means that, although you may change the Offline Action for a particular client in 
the Client Administrator, this change will only come into effect once the client has been able to successfully 
logon to the Web Filter for Citrix server and pick up this new configuration setting.

REPAIRING INTERNET FILTERING PROBLEMS
If the Mobile Filter client detects a problem with its layered service provider (LSP), it will automatically 
attempt to repair it. This type of problem can be caused by tampering with the LSP, or the installation of 
filtering software from a third party manufacturer. The repair process is a privileged operation, so it relies 
on the logged in user having local administrative rights to be able to succeed. The following sections 
describe how to perform the repair on specific operating systems.

If your Mobile Filter client is installed on Windows 2000 or XP, and a problem is detected with internet 
filtering, perform the following:
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1 From the repair prompt , click Fix to start the repair process.

2 Once the repair has completed, click OK. The session will restart. If the repair is unsuccessful, click 
OK, and contact your System Administrator to resolve the problem.
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COMMENTS ON THIS GUIDE?
You can view updated documentation and support information at http://www.surfcontrol.com

Was this guide helpful? E-mail us at documentation@surfcontrol.com to suggest changes or make a 
correction.

Version 5.5

May 2007
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TECHNICAL SUPPORT
For the latest support information on SurfControl products, visit http://www.surfcontrol.com

• Search our Knowledge Base - our new, constantly updated Knowledge Base contains articles, FAQs 
and glossary items to answer your questions about all SurfControl products. 

• Online Support Request - If your question or problem cannot be answered by the Top Issues or is not 
in the Knowledge Base, fill out an Online Support Request Form.

• Telephone Support - If you would like to speak with a Technical Support Representative, our excellent 
SurfControl Technical Support is just a phone call away. 
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SURFCONTROL SALES
For product and pricing information, or to place an order, contact SurfControl. To find your nearest 
SurfControl office, please visit our Web site: http://www.surfcontrol.com
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